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Chapter 1 - Overview 
What is the Solitaire 850 for Windows? 

Solitaire 850 for Windows provides enhanced security for commercial applications.  

Advantages 

Individualized Access 

Administrators can assign access points unique to each user. Every user has exactly the access 
required without the needing to carry multiple keycards  

Protection in case of lost cards 

If a user loses a keycard, an administrator simply encodes a new keycard for him. A count of 
keycards for each user is maintained in the database. A lost card is invalidated when a new keycard 
is created for the same user. 

Extensive Audit Trail 

All Solitaire 850 for Windows locks maintain a record of the last 1000 lock transactions (opening, re-
locking, etc.). A similar audit trail exists on the PC, where all transactions are logged along with the 
name of the administrator. The PC audit trail discourages the encoding and use of unauthorized 
keycards. 

Database Configuration 

The system operates by creating database profiles for each user and each entry point (location) that 
is to be a part of the system. Additional users (up to 1500 per lock) and locations can be added at 
any time. After users and door locations have been entered into the system database, the 
administrator can assign exact access: adding users to doors, or doors to users. Any time a 
transaction is made which affects access, this information must be communicated to the locks 
affected. Reprogramming is a simple matter of connecting a Maintenance Unit (usually a laptop or 
palmtop) to the lock and selecting the programming function. The Maintenance Unit selects the 
proper database for the lock and downloads the new database. The entire transaction takes only a 
few seconds. 

System features 

• Complete heavy-duty mortise or cylindrical lockset 

• Memory capacity of up to 1500 users per lock 

• Audit of the last 1,000 transactions in the lock 

• 16 Timezones (14 are user-programmable) and 18 holidays. 

• Automatic and manual passage mode select 

• Wireless infrared communication with programmer 

• Use of high coercivity keycards for reliability 

• Keycard encoding is proprietary to KABA ILCO 

• Temporary lockout of all user cards 

• Low battery warning from user card 
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• Emergency card overrides all time restrictions and lockouts 

• High-security mechanical key override with audit 

• Easy-to-replace battery pack lasts for approximately 10,000 openings 

• Field-upgradeable software (no need to disassemble unit).  

System Components 

The Solitaire 850 for Windows includes the following components: 

• electronic locks 

• Special keycards 

• User Keycards 

• Encoder 

• Programming module 

• System PC 

• System requirements - general. 

System Requirements - General 

PC/M-Unit system (Separate or Integrated) 

The Separate System is defined as a tabletop PC (for maintaining the database and encoding 
keycards) and a separate laptop PC (for uploading access rights information to the doors and 
downloading audit trail information). Installations with large databases (for example, 10,000 
users/6,000 locks) may require a faster PC and more memory than the systems described below. 

• 32 MB of RAM as an absolute minimum, 64 MB recommended. 

• At least one serial port, two recommended. 

• If no serial port, buy USB adapter.  Contact your KABA dealer for which type to buy. 

• SVGA video card and SVGA color monitor 

• 20 GB or bigger hard disk. 

• 1.44 MB, 3 1/2 " diskette drive. 

• CD-ROM drive.  

• Any IBM compatible printer (to print reports). 

•  Windows 98 (Version 2.0), NT Version 4.0 (with Service Pack 4 installed), XP Pro, or 
2000  operating system . 

 

and 

• Separate Maintenance Unit (M-Unit) - a Pentium 133MHz, or better, notebook compatible 
PC equipped with the following features. 

• 32 MB of RAM as an absolute minimum, 64 MB recommended 

• At least one serial port, two recommended.  

• If no serial port, buy USB adapter. Call Kaba dealer to find out which type  
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• SVGA video card and SVGA color monitor 

• 20 GB or bigger hard disk. 

• 1.44 MB, 3 1/2 " diskette drive 

• CD-ROM drive 

• Any IBM compatible printer 

•  Windows 98 (Version 2.0), NT Version 4.0 (with Service Pack 4 installed), XP Pro, or 
2000  operating system . 

OR 

• The Integrated PC/M-Unit system - may be used instead of the separate system; only one 

• computer is required. 

• Integrated PC/M-Unit - a Pentium 133 MHz, or better, laptop PC equipped with the 
following features. 

• 32 MB of RAM as an absolute minimum, 64 MB recommended 

• At least one serial port, two recommended.  

• If no serial port, buy USB adapter. Call KABA dealer to find out which type. 

• SVGA video card and SVGA color monitor 

• 20 GB or bigger hard disk. 

• 1.44 MB, 3 1/2 " diskette drive 

• CD-ROM drive 

• Any IBM compatible printer 

• Windows 98 (Version 2.0), NT Version 4.0 (with Service Pack 4 installed), XP Pro, or 
2000  operating system . 

Maintenance Unit 

The Maintenance Unit (M-Unit) is a portable laptop or palmtop PC used to communicate with the 
locks by using the Programming Module. 

OR 

You may upload data directly from the System PC to the locks; in this case the PC is referred to as 
the Maintenance Unit. 

The Maintenance Unit (M-Unit) Software performs many tasks. The most important function is 
programming a lock for access to certain users/user groups. Please see Program a Lock on page  
71and follow the procedure. 

The M-Unit also performs several significant monitoring functions. 
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The main menu of the M-Unit  contains several choices 
on dropdown menus. Some functions listed on these menus are the same as the functions assigned 
to the buttons on the M-Unit dialog box above - for example program a lock, audit a lock, transfer 
data from M-Unit to PC or the opposite. One important item is the Options>Configuration which 
shows the following dialog box: 

 
• The PC/M-Unit transfer of information method must also be selected here. Whether you choose 

Direct Update or Diskette is extremely important.  

• The other choices you make will depend on which method you selected.  

• The method you select must also be the same as the one you selected in the Lock Update 
section of the Configuration window dialog box. See the procedure called Set Up Workstation 
on page 14. 

• The setting called Auto-Program is used when you want to program a door but have forgotten 
the door's ID. Choosing auto-program will cause the lock to detect its own ID and identify itself 
during the programming process. 

o Click on the M-Unit button  in the main menu button bar - . The M-Unit dialog 
box appears as shown above. 

o Remember that accessing the M-Unit dialog box in this mode allows you to perform 
programming and monitoring functions on the last door(s) you created files for. It does 
not permit you to create new files. To program a lock or audit a lock with new 

information, you must access the M-Unit through the Upload to M-Unit button  
and follow the procedure in Program a Lock. 

o In this mode, choose the view that you want to see. For example, click on View Lock 
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Audit and the audit trail of your most recently audited lock appears as below: 

 
Similarly, you can click on View Lock Config to see the following fields of the most recently 
downloaded lock configuration. 

 
To view the configuration of another lock, highlight the lock on the list, and then click on View Lock 
Selected and you will get the same information about that lock. 

System PC 

The system PC is used for the following procedures. 

• Maintaining the user database - adding, deleting, and modifying the lists of users and doors. 

• Maintaining the location database - adding, deleting, and modifying the locations (sites, rooms, 
doors) 

• Assigning access - linking the user database and the door database 

• Making keycards - encoding user keycards and special keycards 
• Creating reports - sorting user, location, access, and audit trail data to view on screen or to print 

out hard copies for record keeping 

• Using utilities - system configuration, backing up the databases 

• You must be an administrator to use the Solitaire 850 for Windows software on the system PC. 
For system requirements for the PC, see System Requirements - General. 
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Basic Terminology in Solitaire 850 for Windows 

When configuring Solitaire 850 for Windows, you will use these terms: 

Master Administrator - The person who can change the facility ID, create administrators, users and 
doors, give access assignments, handle data transfers, make Special and User keycards, produce 
reports, and program and audit locks (all of these functions are described in other topics). Master 
Administrators have access to the entire system. Only a Master Administrator can change the facility 
ID. 

Administrators - people who use Solitaire 850 for Windows software for various functions. There are 
3 levels of administrators: Level 1 Administrator, Level 2 and Level 3. For definitions of these levels, 
see Administrator Profiles. 

Users - people who have access to specific doors. Their permission to open certain doors at certain 
times is encoded on their keycards. For a user to open a door, his timezone must overlap with the 
door's timezone. 

Doors - Access control devices, locks, any device that lets you into an area or locks you out. 

User Groups - Users who are grouped together because they all have access to the same door or 
doors. They may work for different departments, have different timezones, etc. but as members of a 
user group they all have access to a specified door. 

Default - The current setting or action taken by hardware or software if the user has not specified 
otherwise. A default value for a Solitaire 850 for Windows means a value that is pre-set, 
automatically assigned until you change it. Default Expiry time, for example, is the time that is 
assigned to all encoded keycards unless you change the time when encoding a specific card.. 

Timezones - Users and doors both have timezones. A User has an individual timezone for when his 
card opens doors to which he has access. A Door has its own timezone. During its own timezone, it 
will admit users who have access privileges or it will admit anyone if it is in Passage Mode. In order 
for a user to enter a door, the timezone for the user and the door must  overlap. 

Passage Modem -  Some doors need to have free passage during peak traffic hours of the day, for 
example that give access to bathrooms or cafeterias. In these cases, the locks have a special 
passage mode option. When a lock is in passage mode, anyone can open the door (no keycard is 
needed). Setting this mode is done when you create a door. See Create Doors. 

Profiles - A user Profile or Door Profile is the record of information you enter, which is then kept in 
the program's database. Each time you change some information in a profile and update that 
information it is saved in the database. 

Sites - Sites are the locations of a group of doors Whether they are in a building or buildings, city, 
town, campus etc. 
Resident User - A resident user is usually a person whose office, lab or other location is accessed 
by a given lock. As a resident, this user has special privileges in controlling the lock. The resident 
user will be able to place the lock into "resident lockout" mode, which restricts access to residents 
only. Non-resident users will be locked out until a resident of that lock (any resident, not necessarily 
the same one who placed it in resident lockout). deactivates the lockout. An Emergency keycard 
gains access to a door in Resident Lockout mode, but the door will remain in Lockout mode. Using 
the Emergency keycard does not change the setting. 

Resident status has other advantages. A resident user can override the Timezone assigned to the 
location. If a user is programmed to be a "resident" in a lock (up to 1500 users can be residents in 
one lock), then only his/her Timezone on the keycard is used to allow access by the lock. The lock's 
Timezone is ignored. 
A user may be assigned resident status for more than one location, and a location may have more 
than one resident user. 
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Windows Terminology 

The screen illustration below shows the basic terminology used in most Windows software to 
describe various types of menus, lists, and buttons. 
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Main Tool Bar 

 
 Let your cursor hover over each of these icons and you will see a description of the action each 
button controls. This description is called a tool tip. Each of these buttons allows you to enter a value 
and/or perform an action to set up your system. When you click on one of these icons, a dialog box 
appears so you can enter data. For example, clicking the Timezone button brings up the dialog box 
shown below, in the Main Menu Bar section. 

Main Menu Bar: 

Lists the major categories of actions you can perform and the different actions in each category in a 

dropdown menu like this.  

Pull the cursor down the menu to highlight the action you want. If you choose Timezones, Vacations 
and Holidays, for example, a dialog box allowing you to configure these time elements appears. 

Dialog Box: 

Provides fields for data you want to enter in your system. You enter data to fill in the blanks, select a 
possible value from a list and/or perform an action, such as Save, Delete or Clear. 
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Action Buttons : 

Action buttons can show words, such as the Save, Delete. Clear and Close buttons in the dialog box 
above, or they can show graphic icons such as the two buttons in the picture of the large screen at 

the beginning of this topic,  and  representing "add a resident to a door" and " 

delete a door assigned to this user". The Add or Move button  moves selected data (for example 
a user or door name) from a list on the right to a field on the left. 

Printing On-Line Help 

To print a single topic: 

Click the print icon  to print the single topic currently being displayed. 

 Note: Underlined text indicates hypertext links that pop up or jump to additional information. The 
hypertext does not print with the topic. In addition, some graphics may not print completely the way 
they appear on screen. 
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Chapter 2 - Getting Started 
Logging in to Solitaire 850 for Windows 

After installation, click the Solitaire 850 shortcut  that appears on the desktop. 

The login dialog box appears. 

•  
• First , log in using KABA as the name and ILCO as the password (you must use upper 

case letters). 

The following screen appears. 
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1. Click OK 

2. You are now in the Solitaire 850 for Windows application. Notice that there are no users in 
the List of Users in the top panel of your screen. 

How do I create the first user? 

1. Select the Users tab on the upper panel . 

2. Select the Profile tab on the lower panel  

Notice that the toolbar and most menu choices are grayed out. You cannot do anything in the 
Solitaire 850 for Windows until you have at least one user in the database. 

 
 

Enter the new user's information in the fields provided on the Registration, Reference and Personal 
Info tabs. 
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Note: You must enter the user’s first and last name, and a user ID. The user ID is numeric and it can 
be any number over zero that is not already taken by another user. The information provided in the 
Reference and Personal Info tabs is optional. 

 
3. Accept the defaults that appear in the other fields - User Group, and Timezone - or select 

other values from the dropdown lists for each field you want to change. 

4. Enter the department name if you wish. 

5. Click on the Update button , the middle button of the three on the right. 

The new user appears in the list of users at the top of the User panel. 

 
 

6. The user's name appears on the list as below. (An icon of the user card with a red X through 
shows that he doesn't have a valid user card yet.) 

 
• Exit the application. 
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• Click on the application shortcut again to re-enter the application. 

• Log in as the first user you created. 

• The main window of the Solitaire 850 appears. 

• Now, add some more users by following the procedure in Add Users on page 32 and then 
create Administrators by following the procedure Create Administrators on page 36. 

• When you begin creating other users, you are acting as a Master Administrator.  

• When you begin creating other users, they will be placed in the default user group (see Create 
User and Door Defaults on page 23) until you create other groups and are able to move the 
users to these other groups. 

• You must always have at least one Master Administrator, one user and one user group in the 
system, you cannot delete the last administrator, user or user group. 

Settings - Workstation 
How do I set up a Workstation? 

Choosing Options from the Main Menu, then Settings>Workstation allows you to configure the 
system for defaults. 
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General 

Use the check boxes to activate the tool tips (the text boxes explaining fields and suggesting actions) 
and the reader/encoder.  

Note: The Facility ID should already have been set by the Master Administrator and will appear in 
this Configuration Window. If it has not been set and you are a Master Administrator you could set it 
here. However, whenever the Facility ID is changed every single lock in the entire system must be 
re-programmed. It's important to have one person set the ID before configuring anything else and to 
always keep that ID. 
The reader/encoder should appear activated. (not grayed out).  

Warning:  If you have active HotSync for a palmtop computer running on your desktop PC, it will 
block COM 1 and you will not be able to use it for the encoder or the programming module even 
if you have plugged in the device and selected COM1 for either device.  Be sure to right-click on 
the Hot sync and de-select Local Serial before selecting COM 1 for either of these devices. 

Right click on the Hot sync logo and the following menu appears 

 
Uncheck Local Serial and COM 1 is now available for your encoder or Programming module. 

How do I activate the lock programming module? 
1. From the main menu, select Options, then Settings>Workstation. 

2. In the Configuration Window dialog box, select the General tab. 

3. Select M-Unit Update Method, Direct or Diskette. 

4. Select your COM port number (Note: COM 1 is often the only available port for laptops). 

5. Click OK. 

You have successfully activated the programming module. To use the module, please 

see the procedure called Program a Lock  on page 71.
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View Options 
How do I change my screen settings? 

1. From the main menu, select Options>Settings. 

•  
For Workstation settings see Settings - Workstation. 

To change background colors and textures, choose the Set background textures item. 

2. To see the toolbar  (Main Menu 
Button Bar described in Windows Terminology) select View Toolbar. 

3. To see messages about the status of your system, select View Status Bar. You should see 
messages like the following appear at the bottom of your window: 

 

Sort Lists 

Select how you want your user and door lists sorted - by name, number etc. This is a default 
preference you are choosing here. 
How do I create list-sorting defaults? 

1. From the main menu, select Options, then Settings>Workstation. The Configuration 
Window dialog box appears. 
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2. The bottom panel of this dialog box allows you to select the defaults for how you want lists 

sorted. For example, you may choose the default here of viewing a list of users sorted by 
last name and it will always come up on screen like the example below, alphabetically by last 
name. 

3. You can sort lists by just clicking on the different column headings when you are looking at 
them or entering data.  

 
4. If you want to see the users by Identification Number, click on Ident and you will see the 

following: 

 

Lock Status Indicators 
An operator with master level authorization to the system can put a lock or all the locks in the entire 
facility in a temporary lockout mode by making and using a Lockout keycard. No keycard except the 
Emergency keycard can open the door. When a user swipes his card when the room is locked out, 
the lock responds with a single red flash and denies access. To take the lock out of the lockout 
mode, the master level operator must swipe a Lockout Reset keycard in the lock. 

Solitaire 850 LEDs - Lock Status Indicators 
The LEDs on the electronic lock flash in a certain sequence, depending on the keycard used, or the 
situation. The charts give the LED flash patterns and their meanings. LED response to situations 

LED INDICATOR FLASH MEANING 

After battery connection no light  The thumbturn is in the passage mode position 

  single red within 4 seconds The thumbturn is in the locked position.  

  still red Battery is low. 

Auto-passage mode 

   single green The lock is automatically set in passage mode. 

   single red The lock is automatically set back to the locked mode. 

Thumbturn is turned (for Passage Mode) 

   single green The lock is put into passage mode. 

   single red 

  

The lock is set back to the locked mode. 
The lock stays in the locked mode in the following cases:
1. Between PASG_END time and PASG-START time. 
2. Resident locked out 
3. Passage mode is disabled 
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4. Deadbolt is thrown 

Thumbturn is turned (for deadbolt) 

   single green Deadbolt lockout is removed. 

   single red Deadbolt lockout is set (passage mode is removed if it 
exists). 

Handle is turned (while in passage 
mode) 
single green and still red 

  
 Battery is low 

Lock failure 

 single red every second The lock has failed 

Key to LED descriptions: 
Green and red = Simultaneous -The green and red LEDs flash together once, 
Green, red = Sequential - The green LED flashes, then the red LED flashes 

Encoding 

Encode Special Keycards 

Keycards should be restricted to those who require them and each person should have one keycard 
with only the access he/she requires. Lost keycards must be reported immediately to ensure 
security. The Emergency keycards should be available to selected personnel: facility managers, shift 
guards, fire marshals, etc. Emergency keycards should not circulate. 
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How do I encode a special keycard? 

Important:  Duplicates may be created for all special keycards.  However, Emergency Reset, 
Lockout, or Lockout Reset may also be created as new keycards, depending on the circumstances 
you encounter. Remember, if you create a new keycard, all previous cards become obsolete.  
Example:  For Emergency Reset, you would create a duplicate if you just need another reset card to 
have on hand but you would create a new card if you had lost the previous Emergency Reset card  - 
because someone else could find it and use it. 

   
  

1. First, read the definitions in Special Keycards on page 61 to understand the functions of each 
Keycard: 

2. From the Main Menu, select System Administration. 

3. Select Special keycards. 

4. In the Keycards dialog box, select the keycard you want from the dropdown menu. In the 
example above, the Emergency keycard has been selected. 

5. An explanation of the card's function appears in the window below the dropdown menu. The 
Keycard history, if any, appears in the bottom panel. 

6. Choose Create a new keycard or Make duplicate from existing by clicking one of the choices and 

then click the Encode Keycard  button at the right. (See Important note at the 
beginnning of this priocedure.) 
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7.  You will see the animated keycard  prompting you to insert a valid keycard. 

8. Insert a blank keycard in your encoder. 

9. The encoder encodes the card and pushes it out. The new SPECIAL KEYCARD appears on the 
keycard history list. 

10. To verify the information on a SPECIAL KEYCARD, select the card you want and click on the Read a 

Card  button on the right. 

11. When the change from Standard time to Daylight Savings occurs, you will receive the following 
message on your screen: 

 
♦ Remember to go to each door with your Daylight Savings card. When the reverse occurs, you 

will receive the following message: 
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How do I make a user keycard? 

1. From the Main Panel select Users tab.  

2. Click on the user who needs a new keycard. 

 

3. In the Lower panel, click on the Keys tab, . Two panels appear: Keycard Generation 
and Keycard History.  

 

 
4. Click on Expiry Date for the card if you choose to set an expiry date. 

Note:  Actual expiry time for the keycard is at midnight of the date of expiry. For example, 
although the selected card in the Keycard History illustration above was created at 10:42 AM in 
1999, it will be good in the lock until midnight on January15, 2005. 

5. A calendar will appear. Select the expiry date you want to assign to that keycard. 

6. Choose Encode the keycard  for the current user, the bottom of the two buttons on the 
right. 

7. You will see the animated card prompting you to insert a valid keycard. 
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8. Insert a blank keycard in your encoder. 

9. The encoder encodes the card, and then pushes the card out and the new User keycard 
appears on the keycard history list. It shows the card count and date. Only this card (the most 
recently issued) will be given access. 

10. All keycard entries except the most recent one are grayed out. The history list can be sorted by 
any of its column headings, including the ID of the operator who encoded the card. Click on each 
of the headings to see how the list can be sorted each time. 

 
11. To verify the information on a user keycard, select the user you want and click on the top button 

-  

12. Insert the user card you just created, and the history of that card, including creation date, will be 
highlighted in the keycard history list. 

13. You have successfully created a user keycard. 

Note: Users whose profile has changed since the last keycard was encoded or who have no keycard 

yet have a symbol  beside their names on the List of Users to show that their current keycards 
are not correct. In the User List shown below, note that the users are sorted by last name. 

 
Note: There is no procedure to delete a User Keycard. Once you have deleted a user, his/her 
keycard is invalid in all locks. See the procedure Delete a User. 
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Defaults 

The default is the current setting or action taken by hardware or software if the user has not specified 
otherwise. A default value for a Solitaire 850 for Windows term, for example default timezone, user 
group or expiry date means a value that is pre-set - automatically assigned until you change it. 
Default User group, for example, is the group that all new users are automatically assigned to until 
you go in and move them to other groups, using the procedure Assign Users to User Groups. 
How do I create user and door defaults? 

1. From the main menu, select Options, then Settings>Workstation. The Configuration Window 
dialog box appears. 

2. Click on the Users and Doors tab and the following screen appears. 

 

 
3. Select a default user group from the dropdown list. Whenever you create a new user, that user 

will automatically be assigned to the User Group indicated here. In the example above, the 
default user group is called Default User Group. The other information: city, state/prov., etc. also 
applies to the new user group. 

Note: When you begin creating other users, they will be placed in that group until you create other 
groups and are able to move them to these other groups. Default User Group is just a holding area, 
so it cannot be assigned to a door and it cannot be deleted, since you must always have at least one 
user group in the system. 
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4. Select a door site, device type and timezone from the dropdown lists. These defaults will be 
applied every time you create a new door. 

5. When all the default values are filled in, click the Enable Defaults check box at the bottom left of 
the dialog box. 

You have now configured the default User and Door settings. 

Default Expiry and Timeout 
How do I set the default expiry for all keycards? 

 
1. From the main menu, select Options, then Settings>Workstation. The Configuration Window 

dialog box appears. 

2. Click on the Expiries and Timers tab and the above screen appears. 

3. From the dropdown menu box for Days, type in (or scroll up or down to) the number of days that 
you want to pass before the card expires. In the example above, the user will have 2000 days 
(just over 5 years) before his card expires. 

4. After you've entered the number of days, the exact date and time of the card's expiry appears to 
the left of the box. The 2000 days shown above is the typical length of time and that sets the 
expiry date as January 11, 2005. 

5. Click OK and the default expiry date is set. 
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6. This is the date that will always show as the expiry date when you create a new card but you can 
change that by following the procedure in Set Expiry Date, part of the procedure called Encode 
User Keycards. 

Note: This dialog box is also used to set times for system activity logs and lock audit logs. 
Information on these topics is available in Maintenance Unit Software. 

7. Set the number of days the system should keep the activity log and the lock audit log. Use the 
counter or just enter the number. 

8. Set the auto log-off for the system. If the system is idle, it will shut down after this preset amount 
of time has elapsed. Use the counter or just enter the number. 

9. You now have default expiry dates set for all cards you will encode and a time period to be 
covered by system activity logs and audit logs. 
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Chapter 3 - Users 
Users - people who can open doors with assigned cards. Their permission to open certain doors at 
certain times is encoded in their keycards. 

Assign Users to User Groups 

How do I assign users to user groups? 

1. Select (click on) the User Group tab on the upper panel.  

2. Highlight (single click) the User Group you want to assign users to. 

 

3. Select the User tab on the lower panel. . 

4. The list on the left of the lower panel, Member Users, shows the users already assigned to the 
selected user group. The list on the right, Other Users, shows all other users in the system. The 
column which is the criterion for sorting the list (Last Name) appears in a different color. A block 
of users can be selected by selecting the first one and holding down the Shift key. 

 
5. From the Other Users list, select the user you want to assign to the User Group. 
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6. Click the add/move button . 

The user is now a member of the group you chose (Finance) and the name appears on the Member 
Users list. Each time you add a new user to a group which has access to certain doors, remember 
that you must re-program the doors (locks) to accept that user, following the procedure in Program a 
Lock on page 71. 

 
Note: Remember that the Default User Group is the one where all new users are placed. When you 
begin creating other users, they will be placed in that group until you create other groups and are 
able to move them to these other groups. Default User Group is just a holding area, so it cannot be 
assigned to a door and it cannot be deleted, since you must always have at least one user group in 
the system. Users can also be assigned to User Groups when you create a user and fill in the User 
Profile. 
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How do I delete users from user groups? 

1. Select (click on) the User Group tab on the upper panel.  

2. Highlight (single click) the User Group you want to delete users from. 

 

3. Select the User tab on the lower panel. . 

4. The list on the left of the lower panel, Member Users, shows the users already assigned to the 
selected user group. The list on the right, Other Users, shows all other users in the system. The 
column which is the criterion for sorting the list (Last Name) appears in a different color. A block 
of users can be selected by selecting the first one and holding down the Shift key. 

 
5. From the Member Users list, select the user you want to delete from the User Group. 

6. Click the delete button . 

The user is now removed from the group you chose (Finance) and the name disappears from the 
Member Users list. Each time you remove a user from a group that has access to certain doors, 
remember that you must re-program the doors (locks) not to accept that user, following the 
procedure in Program a Lock. 

Note: Remember that the Default User Group is the one where all new users are placed. When you 
begin creating other users, they will be placed in that group until you create other groups and are 
able to move them to these other groups. Default User Group is just a holding area, so it cannot be 
assigned to a door and it cannot be deleted, since you must always have at least one user group in 
the system. Users can also be assigned to User Groups when you create a user and fill in the User 
Profile. 
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Assign Users and User Groups to Doors 
How do I assign users to doors? 

1. Click on the Doors  tab in the upper panel. 

2. Select the door to which you want to add a user. 

3. Click on the Users tab  in the lower panel. 

 
4. In the bottom panel on the left you will see the door and a list of user groups that have access to 

that door. On the right of the same panel, you see the remaining user groups. 

5. Click on a user group to see the list of users within the group. In the example above, 

6. Penny Pearl is a member of the Finance user group. 

7. Click on the checkbox next to Penny Pearl's name and then click the move/add button. 

8. The user (Penny Pearl) moves over to the list of Users and User Groups assigned to your 
selected door (D2 - Garage). Notice that she is in the Specific Assignment group because she 
was given access as an individual, not assigned because her whole group was given access. 
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9. If you change your mind and want to remove user or user group from a door, click the user or 

user group's name and then the button at the bottom of the panel above 

You see a message asking if you're sure you want to exclude that person or group. 

� If you click YES for a group, the whole group is moved back to the right-hand panel. 

� If you click YES for a person in the Specific Assignment category, the person is moved back to 
the right-hand panel. 

� If you click YES for a person within a group, that person is grayed out, but he/she remains on the 
current access list until you exclude his group from the door D2 Garage, like Penny Pearl in the 
example below. 

 
 

Note: Users assigned to Doors as individuals, (not as members of a user group which is assigned to 
that door) are listed under the category Specific Assignment - like Grant Brown and Carla Ricci in the 
example above. These individually assigned users may be made Resident in a lock but you can also 
delete their status as residents. On the other hand, users assigned to doors as members of a user 
group (see Assign Doors to User Groups) cannot gain or lose resident status as individuals. They 
can only gain or lose privileges that are given to the whole user group. 

 

Note: The checkboxes next to the users' and user groups' names enable you to move a lot of users 
at once. Although you have to check off each user or group individually, once they are checked you 
only have to click the Move/Add arrow once to move all the names to that door's access list.  
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How do I add a user? 

1. Select the Users tab on the upper panel . 

2. Select the Profile tab on the lower panel  

3. The name of the first user on the List of Users (the user you created in the procedure for Create 
First User) appears by default in the user profile.  

 

4. In the Profile tab of the Users window, click the top button  on the right to clear all fields and 
create a new user. : This Clear action does not delete that user from your database. It just 
removes it from the fields so you can type in the new name. 

 
5. Enter the new user's information in the fields provided on the Registration, Reference and 

Personal Info tabs. 

Note: You must enter the user’s first and last name, and a user ID. The user ID is numeric only. The 
user ID can be any number over zero that is not already taken by another user. The information 
provided in the Reference and Personal Info tabs is optional. 

6. Accept the defaults that appear in the other fields - User Group and Timezone - or select other 
values from the dropdown lists for each field you want to change. 

7. Enter the department name if you wish. 

32                                   PK 2674 05/04 



  Solitaire 850 User Guide 

 

 

8. Click on the Update button , the middle button of the three on the right. 

9. The new user appears in the list of users. 

 
You have successfully added a new user.  
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How do I delete a user? 

1. Select the Users tab  

2. Select the user you want to delete. 

 

3. Select the Profile tab.  

4. Click the Delete User button  - the bottom button of the three at the right of the Profiles 
panel. 

 
5. The program will ask you to confirm your choice with the prompt below. 

6. Click Yes and you have successfully deleted the user. The name will disappear from the list of 
users. 
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How do I find a user? 

1. Select the Users tab . 

2. Select the Profile tab . 

3. The first user on the List of Users appears by default in the user profile. 

4. Select the user you are looking for by clicking on the user's name in the List of Users. 

 
 

 
Now you can simply view the user's settings, change them and update them, or delete the user. 
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Administration Levels 

• Administrator: An administrator is someone authorized to use Solitaire 850 for Windows. 
Administrators must have a password and a defined administrator level.  

• Solitaire 850 for Windows offers four system administrator levels including Master Administrator 
as the system administrator. 

If you are upgrading from a previous KABA ILCO product (System 800, for example) you may bring 
in your database with all its users by following the procedure given in the Solitaire 850 for Windows 
Quick Reference Guide. However, you cannot retain their "administrator" status. You must create 
NEW Master Administrators and all the other levels of administrators - Levels 1, 2, and 3. Of course 
you may use the same names and information but because it is a new system, the Administrators 
must be re-designated to their positions. 
How do I create an administrator? 

1. First, read the topic Administrator Profiles on page 40. 

2. Follow the procedure for Logging in to Solitaire 850 for Windows. 

3. You are now in the Solitaire 850 for Windows application. Notice that there are no users in the 
List of Users in the top panel of your screen. 

4. Follow the procedure in the online help for Create First User on page 12 and create one user. 

5. The user's name appears on the list as below 

 
6. From the top menu, select System Administration>Administrator Profiles or click on the 

Administrator Profiles button.  The following dialog box appears: 
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7. From the dropdown list of users, select the user you created. 

8. In the dropdown list for Level, Master Administrator is the only choice shown, so you are forced 
to select that level and change your created user, Jack Frost, to a Master Administrator. Only a 
Master Administrator can create other Master Administrators, who can then create the other 
users at all levels. That's why you must change this first user to a Master. 

9. Assign a password to the Master Administrator and confirm it. 

10. Click Exit and you will see message asking you if you want to save your changes. 

11. Click Yes and you are prompted to log in again with your new password. 

12. Log in as Jack Frost, the Master Administrator, with the Login name and password you assigned 

 
This Master Administrator cannot delete himself - there must always be at least one However, you 
can create another Master Administrator who can then delete the original one you entered as well 
create all the other levels of administrators. 
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13. If you don't already have a list of users brought in from a previous database, create some users 

in the system, using the procedures Create First User and Add Users. 

14. Click on the Administrator Profiles icon in the button bar  or select System 
Administration>Administrator Profiles from the Main menu. 

15. The Administrator Profiles dialog box appears again. 

 
16. Select the User (from the dropdown list of users that you have imported or created) that you 

want to change to an administrator. 

17. Select the administrator level for this user from the dropdown list. The four administrator levels 
are now available: Master Administrator, Level 1 Administrator, Level 2 Administrator, and Level 
3 Administrator. 

18. Assign each administrator a Login name and a password. 

19. Click Update to save each administrator profile. 

20. Click Exit to exit this window. 

You have successfully completed the procedure and you now have administrators in your database. 
To delete an administrator, follow the procedure in Delete Administrators below. You cannot delete 
the administrator currently using the system. The name of the present administrator is shown in the 
Current Administrator field. 
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Delete Administrators 

1. Click on the Administrator Profiles icon in the button bar or select System 
Administration>Administrator Profiles from the Main menu 

2. The Administrator Profiles dialog box appears again. 

 
21. Select the Administrator (from the dropdown list of users that you have imported or created) that 

you want to delete. 

22. Click Delete to delete this administrator. You cannot delete the administrator currently using the 
system. See the name in the Current Administrator field. 

23. Click Exit to exit this window.  

Note: You must always have a Master Administrator in the system. To change the Master 
Administrator, create a new one and then delete the old one. This means you will have two Master 
Administrators momentarily while you do the changeover. Remember that it is essential to have 
ONLY ONE Master Administrator in the system because he is the one who can change the facility 
ID. If any one else gets in and changes the ID even by mistake, all the doors will have to be 
reprogrammed.  
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Administrator Profiles 

Security Levels 

Solitaire 850 for Windows offers four system administrator levels including Master Administrator as 
the system administrator. 

An administrator is someone authorized to use Solitaire 850 for Windows. Administrators must have 
a password and a defined administrator level.  

Master Administrator: The highest Security Level. The Master Administrator can create all levels of 
Administrator, including another Master Administrator, like Master Password in DOS (Solitaire 800 
System). He can perform ALL Solitaire 850 for windows functions. When you first install Solitaire 850 
software, a default user name and password let the installer log on to the software. You then create 
another user and change him/her into a Master Administrator. After at least one Master Administrator 
is created through the software, a valid logon is required before anyone can get into the system. The 
recommendation is that you create only one Master Administrator 

Level 1 Administrator: (one level below Master Administrator) can perform ALL Solitaire 850 for 
windows functions EXCEPT: 

· create other administrators  

· change the facility ID. 

Level 2 Administrator: can do everything that a Level 1 administrator does EXCEPT: 

· encode some Special Keycards.  

· make Emergency, Emergency Cancel, Lockout or Lockout Reset cards. 

Level 3 Administrator: can do everything that a Level 2 administrator does EXCEPT: 

• · encode keycards 

To see how to designate users as types of administrators, see the procedure for Create 
Administrators. 

Note: When entering information, avoid using symbols in names. For example, if an administrator 
named Mike O'Dell wants his Login ID to be his last name, it should be odell-without an apostrophe. 
The apostrophe is an invalid character for names in 850 software ( - ) and underlines ( _ ) generally 
work fine. 

Profile: A User Profile or Door Profile is the record of information you enter when creating a User or 
Door. The information is then kept in the program's database. Each time you change some 
information in a profile and update the record, the information it is saved in the database. 
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Chapter 4 - Timezones 
• Users and doors both have timezones.  

• A User has an individual timezone for when his card opens doors to which he has access.  

• A Door has its own timezone during which it will admit users who have access privileges 
(either a resident or a user who has a timezone overlapping with the door's timezone) or 
anyone if it is in Passage Mode.  

• In order for a user to enter a door, the timezone for the user and the door must overlap. 

• Example:  If your Timezone for a particular door is "Always" but the door's Timezone is 
9:00 to 5:00, you will not have access to that door after 5:00.  Your card will not work. 

• For timezones to be accurate, they must also reflect the real time - Standard or Daylight 
Savings.  

• A lock can be programmed to have a 24-hour access timezone, no access timezone, or 
any other timezones (up to 14 timezones may be user-programmed).  

• An employee, by default, will be assigned 24-hour access (in 12 blocks of 2-hour time 
slots, from 0 to 24 hours).  

• The lock allows access to this employee only when his timezone and the lock’s timezones 
overlap. In this example, the lock’s timezone is the same as the employee’s timezone, so 
the user has 24-hour access.  

• If the employee had a limited timezone encoded on his card, only the overlap of his 
timezone and the lock’s timezone would allow access. 

•  
The above example assumes that this user is not a resident in the lock. When a user is restricted 
either by the lock’s Timezone or his/her Timezone, the lock responds with a sequence of green, then 
red and green lights, and denies access. For more information on the various lock responses, see 
Lock Status Indicators on page 17. 
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How do I create a timezone?  

1. From the System Administration Menu, select Timezones and Holidays or use the Timezones 

 button. 

 
2. Select the type of timezone from the Zone Type field dropdown list - Doors or Users. 

3. Enter the name of your Timezone in the Zone Name field. Use a name that helps you to 
remember the real time, such as "early morning." 

4. Set the start and end times for the days that you want your new "early morning" timezone to 
apply. H means holidays. 

5. In the above example, the zone called Early Morning means that the door is openable from 4:00 
am to 9:00 am from Monday to Friday and on Sunday but not on Saturdays or holidays. 

6. Click the save button on the right to save the Early Morning timezone. 

7. Select the holidays to apply to the Timezone by clicking on the Holidays tab. 
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8. Add holidays by entering the name and selecting the date of the holiday, then click the save 

button on the right. 

9. You have successfully created a new timezone. 

10. To modify a timezone, choose an existing timezone from the dropdown list for Zone Name and 
modify the hours or holidays following the procedure above, then save. 

Note: When the change from Standard time to Daylight Savings occurs, you will receive the 
following message on your screen: 

 
To remove a timezone, see the procedure below called Delete Timezones. 
 
How do I delete a timezone? 

 
• The Clear action does not delete the Timezone from your database. It just removes the data 

from the fields so you can type in the name of a new timezone. 

• You can see that the "cleared" timezone is still on the dropdown list. 

• Deleting a timezone removes it completely 

1. Select the timezone from the dropdown list of zone names at the top right of the dialog box. 

2. Click Delete. - the middle button on the right. 

3. You have now deleted the timezone. 
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Chapter 5 - Doors 
A door is an access point that requires control. It may be an elevator, stairwell, parking gate or 
anything else that you want to restrict access to. The word "Door" is used for convenience. 

 
How do I find a door? 

1. Select the Door tab . 

2. Click on Profile . 

3. Scroll through the list of doors to find the door you are looking for. 

4. Select the door you are looking for by clicking on it in the list. 

 

 
Now you can simply view the door's settings, create or delete a door. For these procedures, see 
Create Doors and Delete Doors. 
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Assign Doors to Users 
How do I assign doors to users? 

1. Select the User tab on the upper panel.  and select a user, for example 
Peter Piper as below. 

 

11. Select the Access tab  on the lower panel. 

12. The list on the left of the lower panel, Current Access, shows the doors already assigned to the 
selected user, his user group and timezone, as well as the door's timezone. 

13. The list on the right of the lower panel shows the list of all the doors in the system and their 
timezones. 

 
This is a good place to re-check that the door's timezone and the user's timezone overlap. If you 
assign a door to your selected user but his timezone is in conflict with the door's timezone, the user 
will not be able to access that door. Remember that even with a user timezone of "Always", the user 
cannot enter the door if its timezone is, for example, 9:00 to 5:00.  In that case the user cannot enter 
after 5:00. See Keycard Status Indicators table on page 64 for the lock response to a card with a 
valid ID but invalid timezone. 

14. Select the door you want your user to have access to (Plant 1, Side 14th St. in the example 
above). 

 

Click on the add/move arrow button  to assign the door to the access list on the left. 
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15. The door is now accessible to the selected user. The door appears on the user's current access 

list. 

 

 
16. To delete a door assignment from a user, select the door or doors you want to remove from the 

selected user and click the Delete button at the bottom of the panel at the left. 

• Several door assignments can be selected and deleted together. 

• To make the user a resident on that door, follow the procedure in Add a Resident. 

 

 
How do I assign doors to user groups? 

Remember that all users are held in Default User Group until they are assigned to another group. 
Default User Group is just a holding area, so it cannot be assigned to a door. Notice in the screen 
illustration for 4. below that Default is a folder with no content. If you click on it, nothing will happen. 

Only Master Administrators can assign doors to User Groups.  If you are a level 1 or lower, the list of 
doors under the User Group tab is grayed out, so you cannot perform any action. An example is 
shown below. 

1. Select the User Group tab on the upper panel.  and select a user group, for 
example, Finance. 
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2. Select the Doors tab  on the lower panel. 

3. The list on the left of the lower panel, Assigned Doors, shows the doors already assigned to the 
selected User Group.  

4. This list can be sorted by Site, Doors or Location by clicking the appropriate heading.  

5. The list on the right of the lower panel shows the List of User Groups and List of Doors 

 
6. Click on the User Group tab in the panel on the right and you see a list of all the doors that the 

selected user group already has access to.  
For example if you click on the same user group as the user group you selected on the upper 
panel (Finance) you'll see the same list of doors here as the list shown in the lower left panel: 
Finance 01, Side 01 and Side 02. 

7. Click on the Doors List tab on the lower right panel to see the Entire Door list. 

8. Select the door you want to add to your selected User Group. 
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9. Click on the add/move arrow button  to assign the door to the list on the left. 

10. The door is now accessible to the selected User Group. The door appears on the User Group's 
list. 

 
 Door assignments can be copied from another User Group to the selected User Group. To delete a 
door assignment from a user group, select the door or doors you want to remove from the selected 

user group and click the Delete  button at the bottom of the panel at the left. Several door 
assignments can be selected and deleted together. Click on all the checkboxes of the doors you 
want to add or delete, then click on the Add/Move button. 

 

PK 2674 05/04          49 



Solitaire 850 User Guide 

 

Create Doors 
How do I create a door? 

1. Select the Door tab.  

2. Select the Profile tab.  

3. In the Profile section of the Door panel, click on the top button of the three buttons  to 
create a new door.  
This clears all fields and allows you to enter the new name, etc. Do not forget to choose the 
correct type of device: lock, reader, or panic device from the dropdown list in the Device Type 
box on the right. 

 
17. In the form on screen, fill in the name and location of the new door (ST001, Storeroom) 

18. Accept the defaults appearing in the other fields, or change them by selecting another item from 
the dropdown lists for each field you want to change. 

19. Enable Deadbolt and/or Passage Mode. 

20. If you enable Passage Mode, enter the time, auto passage and day settings. 

21. Click on the Update button,  the middle button of the three. 

22. The new door appears in the list of doors at the top of the Door panel. 

 
You have successfully created a new door. To remove a door, see the procedure for Delete Doors. 
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Doors - Passage Mode Restrictions 

When you enter the device type of the door. Passage mode options may be restricted accordingly. 
For example, when you enter Lock as the device type (as in the example above), you have the 
option of selecting thumbturn or keycard as your passage method through the door when it is in 
Passage Mode. However, if you select Reader, the passage method is grayed out as below because 
there is no thumbturn, so you are restricted to keycard only - you cannot choose a method. 

 

 

Deadbolt 

"Deadbolt" on a door may be created in two ways - via software or manually. The deadbolt setting 
must be enabled in the software (as shown in the screen panel below) for either type of deadbolt to 
take effect. Throwing the deadbolt manually will have no effect if the deadbolt setting has not been 
checked off in the dialog box shown below. Anyone who normally has access to the door will be able 
to get in. 

Programmable Deadbolt 

The lock is programmed by the software. The lock on any door may be set to Deadbolt. See the 
procedure in Create Doors. 

 
When Deadbolt is enabled, the door is inaccessible to everyone except residents. Residents in a 
door may enter even if it is set to deadbolt in the software settings (but not if it is manually thrown 
from the inside.) The deadbolt mode can only be removed by unchecking the deadbolt setting shown 
in the screen for the Create Doors procedure. 
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Manually Set Deadbolt 
• The lock on a door may be set to deadbolt manually. A lock with a physical deadbolt 

features a thumbturn on the inside of the door.  

• The deadbolt may be activated (thrown) only by turning the thumbturn manually to the 
horizontal position. If the deadbolt is activated by manual thumbturn, no one can open the 
door until the person on the inside unlocks the deadbolt by returning the thumbturn to the 
vertical position. 

• When the deadbolt is opened, the door returns to its normal mode, timezone and 
admission practices. 

• See Lock Status Indicators and Keycard Status Indicators on pages 17 and on page 64 
for information on indications for deadbolt lockouts. 

•  
How do I delete a door? 

1. Select the Door tab . 

2. Select the Profile tab . 

 
3. In the List of doors at the top of the door tab window, click on the door you want to delete. 

4. Click on the delete button,  

5. A prompt appears as below: 

 
6. If you choose Yes, the door disappears from the list of doors at the top of the Door panel. 

7. Clicking No will cancel the door deletion. 

If you plan to delete an entire Site from the system, you must delete all doors from that site 
first.  
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Passage Mode 

• Some doors need to have free passage during peak traffic hours of the day, for example, 
doors that give access to bathrooms or cafeterias. In these cases, the locks have a 
special passage mode option.  

• When a lock is in passage mode, anyone can open the door (no keycard is needed).  

• Any lock can be programmed to have passage mode start and end times.  

• The lock may be put into passage mode either manually by turning the thumbturn, or 
automatically by using the passage mode time programming feature.  

• Additionally, there is an auto-lock time that also needs to be programmed to fall between 
the passage start and passage end times.  

• The passage end time is also an auto-lock time. If the auto-lock time is programmed to fall 
at the same time or after the passage end time, it is meaningless. The system will not 
allow it to be programmed in that way. 

• For the procedure for setting Passage Mode, see Create Doors 

 

Requirements for Passage Mode: 

• Resident lockout must be cancelled before putting the lock into passage mode using the 
thumbturn.  

• To exit the resident lockout mode, the resident user who created the lockout (or another 
resident in the same lock) must swipe his/her card.  

1. The lock will go through the normal 6-second green light flashing routine, except that 
the first flash is red to indicate to the user that this lock was in resident lockout mode 
until now.  

2. During the flashing period, the user must turn the handle to gain access. 

3. The deadbolt must be retracted before putting the lock into passage mode with an 
employee keycard (if the lock’s deadbolt option is available). 

Consequences of Passage Mode 

• If the lock is in passage mode, a resident cannot enable resident lockout. 

• If the deadbolt is thrown while the lock is in passage mode, passage mode will be cancelled 
and become deadbolt privacy (if the lock’s deadbolt option is available). 

• Passage mode is cancelled when the lock is reprogrammed. 

Passage-Start Auto-lock, Passage-end 

Example 1: Passage Mode start/end is 8:00 and 18:00 Auto-lock programming covers from 16:30 to 
24 hrs 
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• In this example, the lock can be put into passage mode any time between 8:00 and 18:00 by 

flipping the thumbturn on the back of the lock from its normal horizontal position (locked 
mode) to the vertical position (passage mode).  

• Between these times, the thumbturn can be flipped back and forth to toggle the lock 
between the locked and the passage modes.  

• If the lock is left on passage mode during the day, then at 16:30 it will automatically go 
back into the locked mode, though the thumbturn will still physically be left in the vertical 
position.  

• The employees will need to use their employee keycards to gain access after 16:30. 

• Between the auto-lock and passage-end times (between 16:30 and 18:00), the employee 
can again put the lock back into the passage mode if necessary, by “double flipping” the 
thumbturn, that is, turning the thumbturn to the locked mode (horizontal position) once and 
then flipping it back to the passage mode (vertical position). Then at 18:00, the lock 
automatically goes back to the locked mode, though the thumbturn still stays in the 
vertical position. 

 
• The lock cannot be put into the passage mode between the PASG-END time of the 

current day and the PASG-START time of the next day. In other words, the lock will never 
enter passage mode after the programmed PASG-END time; a valid keycard will be 
required to gain access. Every time you flip from the locked to the passage position or 
vice versa, you have to wait up to 4 seconds for the desired mode to take effect. A single 
green flash indicates that you are entering the passage mode. A single red flash indicates 
that you are going back to the locked mode. See Lock Status Indicators. 
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Chapter 5 - Sites 
• Sites are the locations of groups of doors. A site could be a building, a city, town, campus, 

hospital etc.  

•  
How do I add a site? 

1. Select the Doors tab.  

2. Select the Profile tab.  

3. In the Profile tab, click on the square button with 3 dots to the right of the dropdown menu of 
Sites. 

 
4. The Site Names dialog box appears: 

 
5. Enter the new site name and click Add. 

6. The new site then appears in the dropdown menu of sites in the Profile panel. 
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8. You have successfully created a new site. To remove a site, delete all doors from the site, 
following the procedure in Delete Doors on page 52, and then follow the procedure Delete a 
Site on page 56. 

 
How do I delete a site? 

1. First, delete all doors from the site by following the procedure in Delete Doors. 

2. Select the Door tab . 

3. Select the Profile tab . 

4. In the Profile tab, click on the square button to the right of the dropdown menu of Sites. 

 
5. The Site Names dialog box appears 

:  

6. Select the site name and click Delete. 

7. If you have not deleted all doors from the site you will see the warning: 

 
9. If you have deleted all doors, the site disappears from the dropdown menu of sites in the Profile 

panel. 

 

You have successfully deleted a site.  
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Chapter 6 - User Groups 
User Groups  

Users who are grouped together because they all have access to the same door or doors. They may 
work for different departments, have different timezones, etc. but as members of a user group they 
all have access to a specified door or selection of doors.  
 
How do I create user groups? 

You must have a user group already created in the system in order to have a group to put new users 
in. The Solitaire 850 System for Windows opens with a pre-defined user group called Default User 
Group. When you begin creating other users here, they will be placed in that group until you create 
other groups and are able to move them to these other groups. Default User Group is just a holding 
area, so it cannot be assigned to a door and it cannot be deleted, since you must always have at 
least one user group in the system. 

1. Select the User Group tab . 

2. Select the Profile tab  

3. The first user group name (up to 25 characters) and description (up to 50 characters) on the list 
of user groups appears by default in the name and description fields. If you have selected 
another user group, then that name appears in the field. 

 

4. Click the top button on the right  to clear all fields so you can create a new user group. 
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This Clear action does not delete that group from your database. It just removes it from the fields so 
you can type in the new name. Notice that the clear and delete buttons are grayed out after you clear 
the fields, so you can only update after you have entered the new information. 

5. Enter the new user group name. Enter a description if you wish. 

6. Click the middle button on the right  to update the current user group record (save it to 
the database). 

 
The name and description of your new group appears on the list of user groups as below. 

 
You have successfully created a new User Group. To modify a User Group, select a User Group 
from the list and modify the fields in the Profile tab. The Default User Group cannot be modified. 
 
How do I delete a user group? 

1. Select the User Group tab . 

2. Select the Profile tab . 

3. Right-click or double-click the user group you want to delete. 

4. Click the Delete User Group button  - the bottom button of the three at the right of the 
Profiles panel. 
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5. The program will ask you to confirm your choice with the prompt below. 

 
6. Click Yes and you will receive another message to tell you that the users in that group must be 

transferred: 

 
7. Perform the transfer of members to another group, if necessary.   

8. Perform the Delete User Group again following the steps in this procedure. 

9. Click Yes and you have successfully deleted the user group. The group's name will disappear 
from the list of user groups. 
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Special Keycards 

There are 10 Special Keycards: 

• Initialization 

• Program 

• Battery Test 

• Emergency 

• Emergency Reset 

• Lockout 

• Lockout Reset 

• Test 

• Spring/Fall 

• Emergency 

Keycards should be restricted to those who require them, and each person should have one 
keycard with only the access he/she requires.  

Lost keycards must be reported immediately to ensure security. 

The Emergency keycards should be available to selected personnel: facility managers, shift 
guards, fire marshals, etc.  

Emergency keycards should not circulate. 
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Table of Special Keycards 

Duplicates may be created for Emergency, Emergency Reset, Lockout, or Lockout Reset. The other 
Special keycards cannot have duplicates made. The creation of another card will replace the 
previous card. 

Duplicates may be created for Emergency, Emergency Reset, Lockout, or Lockout Reset. The other 
Special keycards cannot have duplicates made. The creation of another card will replace the 
previous card. 

Keycard Function Required Respnse Expiry Duplicates

Emergency 
Opens all locks at all 
times, regardless of 
Timezone, lockout 
condition, or even if the 
deadbolt is thrown. 

For immediate 
access 

1 green flash, lock 
opens 

None Yes 

Emergency 
Reset 

Emergency Reset 
keycard cancels the 
existing Emergency 
keycards for any lock 

When 
Emergency 
keycard is lost 
or stolen 

1 green flash, lock 
opens 

None Yes 

Fall 
turns the lock time back 
by one hour to coincide 
with the Standard Time 
period beginning in the 
Fall. 

on the first day 
of Standard 
Time 

Single Green – 
lock time has been 
adjusted 

None No 

Spring 
advances the lock time by 
one hour to coincide with 
the Daylight Savings Time 
period beginning in the 
Spring 

on the first day 
of Daylight 
Savings Time 

Single Green - 
lock time has been 
adjusted 

None No 

Initialization 
To transfer the unique 
Internal Identification 
number of your software 
to the lock. 

After lock 
installation, after 
battery 
replacement. 

Simultaneous 
green and red 
flashes, followed 
by one green flash 
after first time use 
only. 

None No 

Lockout 
To temporarily invalidate 
all keycards, except the 
Emergency keycard and 
to remove the lock from 
passage mode 
non-duplicate Lockout 
keycard also cancels the 
existing Lockout keycards 

When an area 
must be 
temporarily 
sealed off 

Single Red light seven years 
from time of 
creation 

Yes 

Lockout 
Reset 

Restores the lock to 
normal operation after any 
Lockout Keycard has 
been used. 
Non-duplicate Lockout 
Reset Keycard also 
cancels the existing 
Lockout Reset keycards 

When the area 
no longer needs 
to be sealed off. 

Single Green 
Single Green 

seven years 
from time of 
creation 

Yes 

Programming 
To activate the lock for 
programming or auditing. 

Before 
programming 
and auditing 

One 30-second 
green flash, during 
which time 
communication 
with the 
Maintenance Unit 
(M-Unit) must take 
place. 

No No 

Test (shipped 
with the 
Solitaire 850 
for Windows 
software) 

to verify that the lock is 
operational. 

After the 
physical 
installation of 
the lock is 
complete but 
doors are not 
programmed.  

One green flash, 
access granted. 

Once 
construction is 
complete and 
the locks are all 
programmed 
this card is 
invalid 

No 
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Battery test 
to verify that battery is 
operational. 

Any time Single green and 
red – battery is low 

Yes No 

For information on creating an Emergency keycard, see Encode Special Keycards on page 19.  For 
information on Lock Response, see Keycard Status Indicators on page 64. 

• When the change from Daylight Savings to Standard time occurs, you will receive the 
following message on your screen: 

 
When the change from Standard time to Daylight Savings occurs, you will receive the following 
message on your screen: 
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Keycard Status Indicators 

LED INDICATOR 
FLASH 

 KEYCARD USED  MEANING 

Flashing green (for up to 6 
seconds) 

Emergency and user Access granted, flashing stops when the handle is 
turned. 

Single Green 

  

Test 

Battery Test 
 
Spring 

  
Fall 

  
Lockout Reset 

  
Resident User (same resident user 
keycard is used again within 1 
minute) 

Lock is operational 

Battery is OK. 
 
Lock time is advanced one hour. 
 
Lock time is set back one hour. 
 
Access restored for valid users 
 
The lock is put into passage mode. 

  

 Single red User 
 
Emergency cancel 
 
 
Lockout 
 
Resident User (same Resident 
user keycard is used again within 1 
minute. 

Invalid ID, Access denied 
 
All Emergency keycards created before the Cancel 
keycard are disabled. 
 
Access denied for any valid user card 
 
The lock is set back to the lock mode or stays in the 
lock mode. 
 
   

No light User 
  

  
Emergency and user 
 
 Emergency 
 
 
 All 
 
Initialization 

Lock is locked out, or card is expired or not valid yet. 
 
 The lock time is not set. 
 
This card was cancelled by an Emergency Cancel 
keycard. 
 
Badly encoded or damaged keycard. 
 
Lock already initialized. 

Single green and red  Battery test  Battery is low. 

Single green and red (with 
red longer) 

All  Lock is not initialized. 

Green and red (with green 
longer), green 

 Initialization  Lock is initialized. 

Green and red, green, red  Initialization Lock is initialized and the thumbturn is in the locked 
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LED INDICATOR 
FLASH 

 KEYCARD USED  MEANING 

position. 

Long green (30 sec.)  Programming Communication with lock is enabled. 

Green, red, green  User Valid ID but invalid Timezone; access denied. 

Green, red, red  Non-resident user Valid ID but resident lockout is enabled or deadbolt is 
thrown; access denied. 

Green flash (6 sec.), red  Resident user  Resident lockout is enabled. 

Red, green flashing (for up 
to 6 sec.) 

 Resident user Access granted for the resident user; resident lockout 
removed if handle is turned. 
 Access granted for the resident user; deadbolt lockout 
is not removed. 

Red, green flash (6 sec.), 
red 

Resident user Resident lockout is re-enabled on a resident if the 
handle is not turned during the 6 second flashing phase.

 Flashing green and red (for 
up to 6 seconds) 

 User Battery is low. 

 
Resident Privileges 

• A resident user is usually a person whose office, lab or other location is accessed by a given lock. 
As a resident, this user has special privileges in controlling the lock.  

• The resident user will be able to place the lock into "resident lockout" mode, which restricts access 
to residents only. Only he or another resident in the same lock can take it out of lockout mode. 

• Non-resident users will be locked out until a resident of that lock (any resident, not necessarily the 
same one who placed it in resident lockout). deactivates the lockout.  

• An Emergency keycard gains access to a door in Resident Lockout mode, but the door will remain 
in Lockout mode.  

• Using the Emergency keycard does not change the setting 

• If a user is programmed to be a “resident” in a lock (up to 1,500 users can be residents in one lock), 
then only his/her Timezone on the keycard is used to allow access by the lock. The lock’s Timezone 
is ignored. 

• A resident user can override the Timezone assigned to the location. For example, if a user’s 
Timezone is 8:00 to 20:00, but the location’s Timezone is limited to 9:00 to 15:00, a user with 
resident status for that location will be allowed access from 8:00 to 20:00. 

• A user may be assigned resident status for more than one location, and a location may have more 
than one resident user. 

• To enter resident lockout mode, the resident user swipes the card but must not turn the handle or 
open the door. The green light flashes for 6 seconds, the last flash is a red light and the lock enters 
the resident lockout mode. If a non-resident user tries to swipe his or her card to access this lock, 
the lock responds with a green flash followed by two red flashes and denies access. 

If a lock is to be put into passage mode it cannot be in resident lockout mode. To exit the resident 
lockout mode, a resident user must swipe his/her card. The lock will go through the normal 6-second 
green light flashing routine, except that the first flash is red to indicate to the user that this lock was in 
a resident lockout mode until now. During the flashing period, the user must turn the handle to gain 
access.  
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How do I make a user resident in a door? 

1. Select the Users tab.  

2. Select the Access Tab.  

3. From the list of users in the top panel, select the user you want to assign resident access to. 

 
4. The selected user's User Group and timezone appear in the Access panel below as well as the 

list of doors which that group has access to. 

5. If the door you want is not on the list, highlight the door on the List of Entire System Doors on the 

right (see illustration below) and add it by clicking on the add/move arrow icon.  

 
   The door has been added. 
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10. Do one of the following: 

• double click on the door 

• click on the Resident icon on the bottom left of the panel.  

The following prompt appears. 

: 

11. Click Yes. You have successfully made the current user a resident on that door. Note: The 
information about a door in which a user is resident appears in brown as in the illustration above. 

 
To delete a resident, follow the procedure in Delete a Resident. 
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Delete Resident Access 
How do I delete resident access? 

1. Select the Users tab on the upper panel. . 

2. From the list of users in the top panel, select the user you want to remove resident access from. 

 
3. Select the Access Tab on the lower panel. . 

4. The selected user's user group and timezone appear in the Access panel below, above the list of 
doors which that group or user has access to. 

 
5. Delete the door in which the user is a resident by clicking the delete door icon at the bottom right 

of the door access list . 

6. You have successfully removed resident status on that door for the selected user. The user will 
keep his access to that door but will no longer have resident status. 

You can only remove the door if it was assigned to the specific user by the procedure in Add a 
Resident. You cannot remove the door if it was assigned to the entire user group. Doors assigned to 
a particular user are highlighted in brown. Doors assigned to the group are highlighted in green.   
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Remove a Resident 
How do I remove a resident? 

1. Select the Users tab . 

2. From the list of users in the top panel, select the user you want to remove resident access from. 

 

3. Select the Access Tab . 

4. The selected user's user group and timezone appear in the Access panel below, above the list of 
doors which that group or user has access to. 

 

5. Delete the door in which the user is a resident by clicking the delete door icon  at the 
bottom right of the door access list. 

6. You have successfully removed resident status on that door for the selected user. 

You can only remove the door if it was assigned to the specific user by the procedure in Add a 
Resident. You cannot remove the door if it was assigned to the entire user group. Doors assigned to 
a particular user are highlighted in brown. Doors assigned to the group are highlighted in green. So, 
in both of these user group lists (above and below), you would not be able to remove door access 
from the user. 
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Locks 

All Solitaire 850 for Windows locks are designed to automatically lock each time the door closes to 
maintain top security (unless set to Passage Mode). If a user needs access to a lock (location/room), 
his/her access rights data should be programmed into the lock by an administrator or operator. 

See Program a Lock on page 70. When the correct keycard is entered in the lock reader, the lock 
flashes a green light (for up to 6 seconds) indicating that the user can turn the handle to gain access. 
If the user is not programmed into the lock, the lock flashes a red light once and denies access. For 
other lock responses, see Lock Status Indicators and Keycard Status Indicators. 

Locks - Installation 

The KABA ILCO Solitaire 850 System for Windows Electronic Commercial Lock (ECL) is designed to 
be installed over an existing standard mortise or cylindrical lock cutout. The cylindrical lock can be 
mounted in wood or metal doors. For more information, refer to Programming Locks on page 71. 

Programming Module - definition 

The PC (or M-Unit) communicates with the locks via a programming module. The module attaches to 
the serial port of your PC, laptop or palmtop and to the lock. The infrared receiver and transmitter on 
the module are aligned with those of the lock. 

Programming and Auditing 

You can program and audit the card reader. Link the PC serial communication port to the 
programming module and insert the module into the card reader of the lock. For the procedure on 
how to program the lock, see Program a Lock below. 

 

Locks appearing on the doors with a red traffic light require programming. Green traffic lights 

signify the lock is up to date. See the illustration below, showing Main 001 as the only door on 
that list which needs updating. 
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How do I program a lock by the integrated (direct) method? 

1. Follow the procedure to activate the encoder in Set Up Workstation on page 14 to configure the 
programming module and then the procedure in Maintenance Unit on page 3 

2. Click on Lock Management in the main menu or use the icon for upload to M-Unit , and 
then select Upload Data to Maintenance Unit. 

3. If you have already created the files you want, you can go to step 14. 

 
A list of the doors needing to be updated appears. Do one of the following: 

• Include modified doors only. 

• Click on the Include All Doors button if you want to update all the doors in the Facility. 

A box at the bottom left of the dialog box shows you the quantity of doors you have selected. You 
can also see the file information on the previous M-Unit file created. - file number, date, time and 
size. This could be useful if you need to know the date of creation, for example. 

12. Click Create New M-Unit File. 

The following warning appears: 

 
13. Click Link to Maintenance Unit ((M-unit or M-Unit). 

The M-Unit dialog box will appear on screen, showing the message "Waiting for command". 
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14. Swipe the Programming Special Keycard through the lock and ensure that the light in the lock 

turns green. 

15. Insert the programming module into the lock as follows: 

• Grasp the module between your thumb and forefinger, using your finger to hold in the 
rectangular spring-loaded button on the right-hand side of the module. 

• Push the prongs into the lock's swipe slot so that the top prong goes in just above the flat 
part of the lock, where the surface curves back toward the door. 

• DO NOT FORCE THE MODULE INTO THE LOCK. Remove it and keep trying until you 
feel the prongs slide into place. 

16. After the prongs are in, release the rectangular button on the right of the module and the module 
will remain in the lock.  

17. Click on the Program Lock button on the top left of the dialog box above. You have 30 seconds 
to complete Steps 12. and 13. Remember that 30 seconds is quite long, so do not hurry. If you 
do not complete the action in 30 seconds, you will just receive a message that there was a 
problem communicating with the lock. Just keep trying. 

18. A prompt appears telling you that the programming was successful, or informing you of any 
problems if it was not successful. 

 
How do I program a lock by the separate (diskette method?) 

1. Follow the procedure to activate the encoder in Set Up Workstation on page 14, selecting 
indirect as your method of programming. 

2. If you have already created the files you want, you can go to step 14. 

3. A list of the doors needing to be updated appears. Do one of the following: 
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2. Click on Include Modified Doors Only button. 

3. Click on the Include All Doors button if you want to update all the doors in the Facility. 

4. A box at the bottom left of the dialog box shows you the quantity of doors you have 
selected. You can also see the file info on the previous M-Unit file created. 

5. Click Create New M-Unit File. 

6. The following warning appears: 

 
7. Click Yes. The dialog box will now show the option of loading the file onto a diskette, 

since this is your selected method of programming the locks. 

Note:  Before you create a new file to download, you can copy the previous file to Diskette if you 
didn’t have time before.  Just click on the button at bottom right – Copy Previous File to Diskette. 
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8. Click on Copy New File to Diskette. You will see a message that the file is being 

transferred, and then the following: 

 
9. The data is now on the diskette, which can be inserted into the diskette drive of the M-

Unit laptop or palmtop. 

Note: It's important never to leave a lock in Resident Lockout mode. If the lock is left in that mode 
and then you re-program it as above, it will accept the new data, but the resident lockout will be 
unchanged. The new users will not be able to enter. Ensure that all locks to be programmed are 
taken out of Resident Lockout mode. 

Note: From this M-Unit dialog box, you can also view the lock configurations and the audits of the 
locks you have just programmed and you can reset the lock-timing device.  

Warning: Remember to always disconnect the programming module from your Maintenance 
Unit (especially a laptop or palmtop) when you are not using it. Programming modules (for 
locks with insert-type card readers) contain battery boosters. Leaving them connected to 
your computer will drain the batteries 

Whenever the battery power to a lock is interrupted, (for example, when the battery is changed), the 
date and time in the lock must be reset to the current date and time, since this information is lost to 
the volatile memory. 
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How do I reset the lock date and time? 

1. Click on the button for Start Maintenance Unit. . 

2. The M-Unit dialog box appears. 

 
3. If the battery was removed or replaced, swipe the Initialization keycard. 

4. Connect the programming module to the cable from COM port 1or 2 (whichever you have 
selected) of your M-Unit PC, (palmtop, laptop or desktop) 

5. Swipe the programming keycard through the lock and wait until the green light appears. 

6. Insert the programming module into the lock. 

7. Click on the Reset Lock Time button (at lower right) on the M-Unit. 

8. You will see the following message: 

 
9. The lock date and time has now been reset.                                                                                                                 

  

   

Autoprogram a Lock 

The setting called Auto-Program is used when you want to program a door but have forgotten the 
door's name. Choosing auto-program will cause the lock to detect its own ID and identify itself during 
the programming process. 

1. Click on the M-Unit button  in the main menu button bar. The M-Unit dialog box appears as 
shown below. 
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10. From the Options menu, select Options>Configuration. The following Dialog Box 

appears: 

 
11. Select the Auto-Program checkbox. Select this option if you want the PC to 

automatically identify the lock ID. 

12. Click on OK. 

13. When you go to the procedure in the Help topic called Program a Lock and follow the 
steps, the dialog box for programming the locks appears with the Auto Program button 
at the top left shown as below instead of the usual button called Program Lock. 

 
14. Follow the procedure in the topic called Program a Lock on page 71, clicking on the 

Auto Program button. 

15. The lock's ID will appear in the dialog box, and the result will read Auto Programming 
Completed. 
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Chapter 7 - Reports 
• In addition to the audit trail on each lock that records who entered or tried to enter a room, 

the PC keeps a record of any transaction performed on it. 

• The PC stores the previous 2,000 transactions and will allow you to print or view these 
transactions in a variety of categories. 

• The PC audit trail prevents fraudulent use of the PC by those with valid operator 
passwords. 

• All operators should know about this feature in order for the prevention to be effective. 
You should make periodic printouts of the audit trails for your security records.  

The following reports can be run, viewed on screen, and printed: 

• Cards 

• Changed Doors 

• Doors 

• Doors by User 

• Doors by User Group 

• Holidays 

• Lock Audits 

• Operators 

• System Activity Log 

• Timezones 

• Upload data to the maintenance unit 

• Users 

• Users by Door 

• Valid Cards 

A description of each report is displayed in the report selection window. See also Running a Report 
on page 80.  
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Report information 
How do I include company information on my reports? 

The information you enter here will appear at the top of any system reports you run. This information 
is entered using the following procedure. 

1. From the Main Menu bar, select Options, then Settings>Workstation. 

2. The Configuration Window dialog box appears. 

3. Select the Company Info tab. 

 
4. Fill in your company name and address and click OK. 

5. Your company name and address will automatically appear on all reports you generate on any 
subject. 
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How do I run a report? 

 

1. Click on the Report button  on the main toolbar, or select Reports from the File menu. The 
Reports dialog box appears as above. 

2. Choose the report you want to run from the list provided. A description of what you will see in the 
report appears under the list window. 

3. Click on Run Reports 

4. A Customizing Report dialog box appears. 

 
5. Select the field you want the report to sort by and then the fields for the report range. 

6. On the right of the dialog box, choose the percentage of the screen you want to use to view the 
report and then click Preview, Print, or Export. Naturally, in order to print the report, you must 
have the correct printer drivers installed. 

Note: Doors by Users and Users by Doors are the two reports that will take the longest to compile 
because there could be a large amount of data to check. You may have to wait a few minutes before 
the Preview appears. 

7. Your preview screen should show a report like the example below. If there is no company 
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identification on your report, follow the procedure in Report Information. 

 
The Export action involves other dialog boxes that will appear sequentially asking you to choose 
value separators, format and destination for the report. 

8. Select the destination you want to export the report to. 

 
You have a wide choice of applications and document formats as the destinations. After selecting the 
destination format, you will choose the separator.  

9. Select the type of separator appropriate to the destination application. Some applications such 
as Microsoft Excel don't need separators for data, as the data appears in cells. 
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 Next, you can select the date and time formats for your report, or accept the formats built into the 
overall format you have chosen. This is mainly a question of preference for day/month/year or 
month/day/year. 

 
Here is an example of commonly printed reports in common formats. 
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Doors by Users in Excel 5.0 

PK 2674 05/04          83 



 

 
  

 

 

 

 

 

 

 

 

 

 

2. Users in Crystal Reports (.rpt) 
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The variety of reports and versatility of formats makes the reporting feature one of the outstanding 
features of the Solitaire 850 for Windows. 
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Chapter 8 - Database Utilities 
How do I import my System 800 Database using DB Utility? 

WARNING: A special import program lets you put data directly from System 800 into Solitaire 
850 for Windows through the DB Utility. Refer to How to Use the Solitaire 850 Database Utility 
in the Solitaire 850 Quick Reference Guide. MAKE SURE YOU HAVE A CURRENT BACKUP OF 
YOUR SYSTEM 800 DATABASE before you import it into Solitaire 850 for Windows. 

WARNING: When you import the system 800 database into Solitaire 850 for Windows, all 
doors are set as being updated (they appear with green lights). Therefore, BEFORE YOU 
IMPORT THE DATABASE, MAKE A NOTE OF ALL DOORS WHICH NEED TO BE UPDATED so 
you can carry out the update in the Solitaire 850 for Windows. Remember if you don't write 
down which doors need to be updated and the data they need you will lose that information 

WARNING: Before installing the application Solitaire 850 for Windows, it is very important to 
verify that your computer clock settings are correct and are set for the correct timezone. 
Failure to ensure that the date and time are correct on your PC may cause severe problems 
with the installation. 

How do I open the Database Utility 

1. Install Solitaire 850 from your installation CD. 

2. Click on Windows Start icon on your PC 

3. Choose DB Utilities from your Solitaire 850 group of icons and click on the icon. 

4. The following login dialog box appears. 

 
5. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 

imported or created a database OR log in with the name of the Master Administrator you created 
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after logging in to the Solitaire 850 for Windows. The logo below tells you are in the database 
utility. 

  
6.  From the Main Menu button bar click on the Import System 800 database. The following screen 

appears: 

  
16.  Click on the ImportSys800 button. The next dialog appears 

PK 2674 05/04          87 



 

 
17.  Click OK if the location is correct. 

18. You will see the following message warning you that the process may take time. If you 
have a slower computer or a large database, please be patient and wait till the process 
is complete. 

 
19.  During the time that the utility is importing the data, you will see a message asking you 

to wait until the process is complete. 

20.  When the process is complete, the following dialog box appears: 

  
21.  Click on OK after you see a message informing you that the import process has 

terminated. 

Note: If you are upgrading from a previous KABA ILCO product (System 800, for example) you may 
import your database with all its users. However, you cannot import administrators. You must create 
NEW Master Administrators and all the other levels of administrators - Levels 1, 2, and 3. Of course 
you may use the same names and information but because it is a new system, the Administrators 
must be re-designated to their positions. 
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How do I Export Users to ASCII Files? 

WARNING:  Once you have exported files to ASCII for use in Millenium products - Millenium Entry, 
Enterprise or Expert, you cannot re-import the same files back into the Solitaire 850 system.  The file 
format will be incompatible.   

To perform any database operations, you must open the separate file DB Utility application installed 
when the Solitaire 850 for Windows was installed. Database operations cannot be conducted from 
the program when it is running. 

Note: The database operations are for stand-alone Solitaire 850 for Windows software 
configurations. If your Solitaire 850 for Windows runs in a NETWORK configuration, DO NOT 
PERFORM THESE DATABASE OPERATIONS. See your database administrator for instructions. 
The Solitaire 850 for Windows Database function automatically compacts the history database as 
part of the process. 

1. Click on Windows Start icon   on your PC. 

2. Choose DB Utilities from your Solitaire 850 group of icons and click on the icon   

3. The following Login dialog box appears 

 

 
  

4. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
imported or created a database. 

OR 

5.  Log in with the name of the Administrator you created after logging in to the Solitaire 
850 for Windows. The logo below tells you are in the DB Utility. 
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6. Click on the ASCII button on the main menu button bar.   

The following window appears: 

 
7. Select the file you want to export to Millenium - the user database in the example 

above.  

8. Select Display Export and Display Log to view the process and results of exporting the 
file. 

9. Go to the log file location and click on the Users log as shown below. 
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10. The log opens in Notepad and tells you the export was successful. 
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Database Utilities - Compact and Repair 

• The Solitaire 850 for Windows includes a repair and compact function. 

• To perform any database operations, you must open the separate file DB Utility 
application installed when the Solitaire 850 for Windows was installed. Database 
operations cannot be conducted from the program when it is running. 

Note: The database operations are for stand-alone Solitaire 850 for Windows software 
configurations. If your Solitaire 850 for Windows runs in a NETWORK configuration, DO NOT 
PERFORM THESE DATABASE OPERATIONS. See your database administrator for instructions. 
The Solitaire 850 for Windows Database function automatically compacts the history database as 
part of the process. 

• Repairing the database is not a regular routine. Only special situations call for the repair 
or compact procedure, as directed by Technical Support. 

 
How do I repair the database? 

1. MAKE SURE YOU HAVE A CURRENT BACKUP OF THE DATABASE before performing 
any repair or compact procedures. 

2. Click on Windows Start icon  on your PC. 

3. Choose DB Utilities from your Solitaire 850 group of icons and click on the icon . 

4. The following Login dialog box appears 

 
5. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
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imported or created a database OR 

6.  Log in with the name of the Master Administrator you created after logging in to the 
Solitaire 850 for Windows. The logo below tells you are in the DB Utility. 

 

7. Click on the database repair button  on the main menu button bar. 

8. The following window appears: 

:  

9.  Highlight the Solitaire 850 for Windows database to be repaired. 

10. To repair the database, click the Begin Repair button. 

11. The following message appears: 

 
12. Click the Save button to save the repaired database or click the Cancel button. The dialog 

box lets you know when the process is finished. 

PK 2674 05/04          93 



 

13. Press Close to close the dialog box, or continue to repair another database. 

 
 How do I compact the database? 

1. To perform any database operations, you must open the separate file DB Utility installed when 
the Solitaire 850 for Windows was installed. Database operations cannot be conducted from this 
program when it is running. 

 

Note: The database operations are for standalone Solitaire 850 for Windows software 
configurations. If your Solitaire 850 for Windows runs in a NETWORK configuration, DO NOT 
PERFORM THESE DATABASE OPERATIONS. See your database administrator for instructions. 
The Solitaire 850 for Windows Database function automatically compacts the history database as 
part of the process. 

2. Compacting the database need not be a regular routine. Only special situations call for the repair 
or compact procedure, as directed by Technical Support. 

3.  Make sure you have a current backup of the database before performing any compact 
procedures. 

4.  Click on the database compact button on the main menu button bar. The following window 
appears: 

 
5. Highlight the Solitaire 850 for Windows database to be compacted. 

6. To compact the database, click the Begin Compact button. The following message appears: 

 
7. Click the Save button to save the compacted database or click the Cancel button. The dialog box 

lets you know when the process is finished. 

8. Press Close to close the dialog box, or continue to compact another database. 
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Database - Backup 

� Solitaire 850 for Windows comes with a special database utility program that restores, transfers, 
compacts and repairs your database. 

� To perform these database operations, you must open the separate file DB Utility installed when 
the Solitaire 850 for Windows was installed. Database operations cannot be conducted from the 
program when it is running. 

� MAKE SURE YOU HAVE A BACKUP OF YOUR CURRENT DATABASE before performing any 
repair or compact procedures. 

� You can back up your current database from the Solitaire 850 for Windows. There is no need to 
go to the DB Utility application. 

Note: If you back up your database on diskettes, BE SURE THAT THE DISKETTE IS NEW OR 
COMPLETELY EMPTY. If there is already data on the disk, the database backup will not succeed. 
Also, be sure to have multiple backups on diskette, rather than using the same diskette over and 
over again. We recommend that you keep at least three previous backups at all times if you are 
using diskettes. Diskettes can easily be lost or damaged. 

How do I back up my current database? 

1. From the main menu, select Options>Settings>Workstation and click on the Backup Database 
tab at the far right of the dialog box. You must click on the arrow pointing right in order to see this 

tab.  The following dialog box appears: 

 
2.  Select the number of backups you want to keep on the hard drive - at least three is 

recommended. 

3. Click on the File Location button to see the path where you want to store your backup. 
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4. Change the location if you want by browsing for the new path or just click on OK to accept the 

location shown. 

5. From the File dropdown menu on the main menu, select Backup Database 

 
6. Verify that the database was backed up by checking the location you chose, to see if it's there. 
How do I back up my current database using diskettes? 

1. Insert a blank diskette in your disk drive. 

2. From the main menu, select Options>Settings>Workstation and click on the Backup Database 
tab at the far right of the dialog box. You must click on the arrow pointing right in order to see this 

tab.  The following dialog box appears: 
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3.  Insert a diskette into your diskette drive. 

4. Click on the File Location button to see the path where you want to store your backup. 

 
5. Change the location from C:\ to your diskette drive (A;\ for example) by browsing for the new 

path. 

6.  From the File dropdown menu on the main menu, select Backup Database 

 
7. Verify that the database was backed up by checking the diskette to see if the data is there. 

You have successfully copied your database onto the diskette. See the procedure called Database 
Utilities - Restore when you want to use this database again. 

Database Utilities - Restore 
How do I restore my previous Solitaire 850 for Windows Database? 

If you have to re-install the Solitaire 850 for Windows application, a special Restore program lets you 
put your previous database into the new Solitaire 850 for Windows. To do this, you use the DB 
Utility. Refer to How to Use the Solitaire 850 Database Utility in the Solitaire 850 User Guide or 
follow the procedure below. 

1. Click on Windows Start icon on your PC. 

2. Choose DB Utilities from your Solitaire 850 group of icons and click on the icon. 

3. The login dialog box appears. 

4. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
imported or created a database OR log in with the name of the Master Administrator you created 
after logging in to the Solitaire 850 for Windows. The logo below tells you are in the database 
utility. 

5.  From the Main Menu button bar click on the Restore 850 database. 

6. The following screen appears: 
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7.  Click on the filename of the database you want to restore 

If you are restoring from a diskette (probably drive A:\), the file list will be empty or not visible. Just 
click on the Restore Selected File button to initiate a Restore. It will take a long time, so please be 
patient and do not touch your keyboard or the diskette. The system will prompt you to insert a new 
diskette if and when necessary. It will inform you when the operation is complete as shown below. 

8. The following message appears when the restoration is complete. 

 
9.  Click on OK after you see the message informing you that the import process has terminated. 

If you are restoring from a previous Solitaire 850 for windows, the database will be restored exactly 
as it was. The various administrators still retain their status and any doors that need updating are still 
indicated. This is different from importing a database from a previous product such as the Solitaire 
800 where you lose these attributes.   
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